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About this manual1.

Copyrights1.1.

The information in this document is subject to change without notice and should not be
construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any
errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental, or consequential
damages of any nature or kind arising from the use of this document, nor shall ABB Oy
be liable for incidental or consequential damages arising from use of any software or
hardware described in this document.

This document and parts thereof must not be reproduced or copied without written per-
mission from ABB Oy, and the contents thereof must not be imparted to a third party
nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and
may be used, copied, or disclosed only in accordance with the terms of such license.

© Copyright 2011 ABB. All rights reserved.

Trademarks1.2.

ABB is a registered trademark of ABB Group. All other brand or product names men-
tioned in this document may be trademarks or registered trademarks of their respective
holders.

General1.3.

This manual provides thorough information on the MNSis OPC Server and the central
concepts related to it. You find instructions on how to configure the MNSis OPC Server
related objects. The basic operation procedures are also discussed.

Information in this user’s manual is intended for application engineers who configure
the MNSis OPC Server.

This user’s manual is divided into following sections:

Introduction

This section gives an overview of the MNSis OPC Server and its features.
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Configuration

In this section you will find an overview of configuration. You are given instructions
on how to configure MNSis OPC Server related objects and the model of a substation
or system.

Document conventions1.4.

The following conventions are used for the presentation of material:
• The words in names of screen elements (for example, the title in the title bar of a

window, the label for a field of a dialog box) are initially capitalized.
• Capital letters are used for the name of a keyboard key if it is labeled on the keyboard.

For example, press the ENTER key.
• Lowercase letters are used for the name of a keyboard key that is not labeled on the

keyboard. For example, the space bar, comma key, and so on.
• Press CTRL+C indicates that you must hold down the CTRL key while pressing

the C key (to copy a selected object in this case).
• Press ESC E C indicates that you press and release each key in sequence (to copy

a selected object in this case).
• The names of push and toggle buttons are boldfaced. For example, click OK.
• The names of menus and menu items are boldfaced. For example, the  File menu.

• The following convention is used for menu operations: MenuName > Menu-
Item > CascadedMenuItem. For example: select File > New > Type.

• The Start menu name always refers to the Start menu on the Windows taskbar.
• System prompts/messages and user responses/input are shown in the Courier font.

For example, if you enter a value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 - 30 .

• You can be asked to enter the string MIF349 in a field. The string is shown as follows
in the procedure:

MIF349
• Variables are shown using lowercase letters:

sequence name

Use of symbols1.5.

This publication includes warning, caution, and information icons that point out safety-
related conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should be interpreted as follows.
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The electrical warning icon indicates the presence of a hazard
which could result in electrical shock.

The warning icon indicates the presence of a hazard which
could result in personal injury.

The caution icon indicates important information or warning
related to the concept discussed in the text. It may indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.

The information icon alerts the reader to relevant facts and
conditions.

The tip icon indicates advice on, for example, how to design
your project or how to use a certain function.

Terminology1.6.

The following is a list of terms associated with COM600 that you should be familiar
with. The list contains terms that are unique to ABB or have a usage or definition that
is different from standard industry usage.

DescriptionTerm

An abnormal state of a condition.Alarm

An OPC service for providing information about alarms and
events to OPC clients.

Alarms and Events; AE

An OPC service for providing information about process data to
OPC clients.

Data Access; DA

Part of a logical node object representing specific information,
for example, status, or measurement. From an object-oriented
point of view, a data object is an instance of a class data object.
DOs are normally used as transaction objects; that is, they are
data structures.

Data Object; DO

The data set is the content basis for reporting and logging. The
data set contains references to the data and data attribute val-
ues.

Data Set
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DescriptionTerm

A physical device that behaves as its own communication node
in the network, for example, protection relay.

Device

Change of process data or an OPC internal value. Normally, an
event consists of value, quality, and timestamp.

Event

A physical IEC 61850 device that behaves as its own commu-
nication node in the IEC 61850 protocol.

Intelligent Electronic Device

Representation of a group of functions. Each function is defined
as a logical node. A physical device consists of one or several
LDs.

Logical Device; LD

The smallest part of a function that exchanges data. An LN is
an object defined by its data and methods.

Logical Node; LN

A communication protocol developed by Echelon.LON

A proprietary method of ABB on top of the standard LON pro-
tocol.

LON Application Guideline for
substation automation; LAG

Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

OPC

Representation of a connection to the data source within the
OPC server. An OPC item is identified by a string <object
path>:<property name>. Associated with each OPC item are
Value, Quality, and Time Stamp.

OPC item

Named data item.Property

The report control block controls the reporting processes for
event data as they occur. The reporting process continues as
long as the communication is available.

Report Control Block

ABB proprietary communication protocol used in substation
automation.

SPA

Protection and/or Control Product supporting the SPA protocol
version 2.5 or earlier.

SPA device

XML-based description language for configurations of electrical
substation IEDs. Defined in IEC 61850 standard.

Substation Configuration Lan-
guage; SCL

Abbreviations1.7.

The following is a list of abbreviations associated with COM600 that you should be
familiar with. See also 1.6, Terminology.

DescriptionAbbreviation

Alarms and EventsAE

Application Service Data UnitASDU

Buffered Report Control BlockBRCB
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DescriptionAbbreviation

Data AccessDA

Data Message Code DefinitionDMCD

Data ObjectDO

Gateway, component connecting two communication networks togetherGW

Human Machine InterfaceHMI

International Electrotechnical CommissionIEC

Intelligent Electronic DeviceIED

LON Application Guideline for substation automationLAG

Local Area NetworkLAN

Logical DeviceLD

LonMark interoperable device communicating in LonWorks network. In
this document, the term is used for devices that do not support the ABB
LON/LAG communication.

LMK

Logical NodeLN

LON SPA GatewayLSG

Network Control CenterNCC

Norwegian User ConventionNUC

Network VariableNV

Object Linking and EmbeddingOLE

OLE for Process ControlOPC

Protection & ControlP&C

Request To SendRTS

Substation AutomationSA

Station Automation Builder 600SAB600

Substation Configuration LanguageSCL

Single Line DiagramSLD

Simple Network Management ProtocolSNMP

Simple Network Time ProtocolSNTP

Simple Object Access ProtocolSOAP

Report Control BlockRCB

Unbuffered Report Control BlockURCB

eXtended Markup LanguageXML
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Related documents1.8.

MRS numberName of the manual

1MRS756125COM600 User’s Manual

Document revisions1.9.

HistoryProduct revisionDocument version/date

Document created3.2A/17.6.2008

Document revised3.3B/13.2.2009

Document revised3.4C/06.11.2009

Document revised3.5D/30.06.2011
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Introduction2.

Functional overview2.1.

MNS iS OPC server is used for the communication to the MLink devices. COM600 and
MLink devices are physically connected together using the LAN connections. MNS iS
OPC server is connected to the COM600 software using an MNS iS connectivity server.
MNS iS connectivity server remodels and links the data from the MNS iS OPC server
to the IEC 61850 data model used by the COM600 applications. OPC DA is used between
the MNS iS OPC Server and the connectivity server.

Figure 2.1-1 MNS iS connectivity server overview

IEC 61850 data modeling2.2.

IEC 61850 data modeling is described in further detail in section IEC 61850 data mod-
eling of COM600 User's Manual.

Features2.3.

The MNS iS connectivity server supports the following features:

• OPC Data Access Server v. 1.0/2.0
• OPC Alarms and Events Server v. 1.10
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• OPC Data Access Client v.2.0
• IEC 61850 data modeling

The following data can be used from MNS iS OPC DA Server in COM600:

• Measurement values
• Trip and alarm indications
• Device Status indications
• Communication status indications

Timestamps for data changes in the MNS iS OPC DA OPC server are not transferred
from IEDs. They are created by the OPC server based on the computer system time.

The recommended maximum number of MControl devices that can be connected to one
COM600 is 180.
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Configuration3.

About this section3.1.

This section describes the installation and configuration of the MNS iS OPC server.

Overview of configuration3.2.

To commission COM600 MNS iS, install the MNS iS OPC Server to the COM600
computer. The COM600 MNS iS Connectivity Server configured using Station Automa-
tion Builder 600 (later referred to as SAB600).

The configuration of the MNS iS OPC Server prepares COM600 to communicate with
the MNS iS devices and retrieving the data to the OPC server namespace. The connectivity
server configuration links the data from the MNS iS OPC Server to COM600 framework,
to be used with other COM600 functions like the HMI and gateway.

MNS iS OPC Server installation and configuration3.3.

Installing MNS iS OPC Server

To install the MNS iS OPC Server:
1. Run the executable file C:\ABB MNS iS OPC Server Installation Pack-

age\1TGE160005R0004_ABB_MNSiS_OPC_Server_5_4c Setup.exe.
2. At the end of the installation sequence, a dialog with the "Show the readme file"

check-box is displayed. Clear the check-box or you will receive an error reporting
that the installation failed. You can later select the readme file (ABB MNS iS OPC
Server_Readme.txt) from the C:\Program Files\ABB\ABB MNS iS OPC Server
directory.

3. When the installation has been completed, run the register.bat file located in the
same directory as the MNS iS OPC Server installation package. After that you are
ready to configure the MNS iS OPC server.

DCOM Configuration

When configuring the MNS iS OPC server, run under COM600 user account

To modify the DCOM configuration, select:

Start > Settings > Control Panel > Administrative Tools > Component Services >
Component Services > Computers > My Computer > DCOM Config
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1. Right-click on ABB MNS iS OPC DA Server and select Properties.
2. Select Identity tab
3. Check This user option and enter COM600 to the User field and the correct password

to the password fields.
4. Click Apply to accept the changes.

If the password of the COM600 user is changed later, for example, with SAB600 man-
agement tool, this password must be manually changed for the MNS iS OPC server as
described above.

Namespace Configuration

MNS iS OPC server software package has a service which scans the network for MLink
devices. When MLink devies are found, they are added to the OPC server namespace.
If a previously found device does not respond, it is removed from the namespace. In
COM600 environment, it is preferable to maintain the namespace static and therefore
the dynamic update of the namespace must be disabled during normal operation. Enable
scanning only when new devices are added to, or permanently removed from the config-
uration. Only devices that are connected to COM600 should be available on the network
when the scanning service is enabled. Otherwise all found devices are added to the
namespace, which creates an unnecessary load to the OPC server.

To enable or disable scanning using the windows service management console in
COM600:

1. Select Start > Settings > Control Panel > Administrative Tools > Services
2. Locate the file MOPCSrv.exe from the list and double-click it.
3. Change the Startup type to Manual.
4. Use the Start and Stop buttons the start and stop the service.

When the new devices are added or old ones are permanently removed, start the scanning
service as explained above using the Service management console

1. Stop the OPC server by ending the MNSiSDAS.exe process using the task manager
2. Start the OPC server. The COM600 service restarts the OPC server automatically.

You can also use third party OPC test client start the OPC server.
3. Wait until the scanning service has updated the changes to the configuration. You

could use third party test client to verify that the namespace is correctly updated.
4. Stop the scanning service
5. Stop the OPC server
6. Restart the OPC server, check that the namespace is correct
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MNS iS OPC Connectivity Server Configuration using
SAB600

3.4.

Building Object Tree

Building the object tree in the communication view of SAB600 is described in section
Building object structures of COM600 User's Manual.

In the communication structure, the subnetwork object is used to group the MControl
devices which are connected to separate MLink devices. If the communication status of
the MLink is needed as an own signal, an own IED for the Mlink must be created as
well. Below this IED an LD and LLN0 with Health mapped to the communication status
must be created. MControl devices are presented as IEDs in the tree. The data from the
MControls is modeled as data objects below logical nodes and logical devices. The LLN0
Health must be mapped to the communication status OPC item of the MNS iS OPC
Server.

MNSiS_object_tree.png

Figure 3.4-1 MNS iS OPC server object tree example
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Configuring objects3.5.

Server and subnetwork object do not normally need any change to the default values of
the properties. On the IED object, the event definition for the device connection status
is configured according to the needs of the project.

Data objects contain the OPC item paths to the MNS iS OPC server. This specifies the
source data used to update the values of the data object. Below is an example of SPS
data which gets its value from the MLink33.2.DeviceStatus.GPI1 OPC item from the
MNS iS OPC Server.

• Update Rate property specifies the maximum rate the OPC server updates the item.
• The shortest rate supported by the MNS iS OPC Server is 1000 ms.

MNSiS_object_properties.png

Figure 3.5-1 An example of MNSiS object properties
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